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Important Security Information
Improper configuration of the CTE 1400 Series can result in a security risk. Before you deploy th
CTE 1400 Series, verify that the CTE 1400 Series does not have access to protected intranet sit

By default, the CTE 1400 Series proxies only the web pages that it has identified (transcoded in D
Studio) to prevent access to protected servers that are on the same subnet as the CTE 1400 Serie
choose to override that default, do not put the CTE 1400 Series on the same subnet as protected s

Note If you configure the CTE 1400 Series to proxy all web pages, the CTE 1400 Series provides acce
to computers on the same subnet as the web servers that are configured to work with the CTE 14
Series. For example, suppose a CTE 1400 Series has an external IP address of 24.221.1.1 and 
internal IP address of 192.168.1.31. On the same subnet, you have an intranet server, protected fr
outside access, with an IP address of 192.168.1.20. You can access all ports on the protected intra
server through the CTE 1400 Series by using the URLhttp://24.221.1.1/http://192.168.1.20.

Also, be aware of the following security considerations:

• Cisco IP Phone/CTE Connection

Because the Cisco IP Phone does not support SSL, the connection between a Cisco IP Pho
the CTE is not secure. We recommend that you locate the connection between a Cisco IP Phon
the CTE behind a firewall.

• SSL to non-SSL redirects

When Design Studio is redirected to an SSL site from a non-SSL site (from HTTPS to HTTP),
connection between Design Studio and the CTE is not secure. We recommend that you loca
connection between Design Studio and the CTE behind a firewall.

System Requirements
The Design Studio application requires the following:

• Windows 95, Windows 98/ME, Windows 2000, or Windows NT 4.0 with Service Pack 6.

• At least 10 MB of disk space.

• At least 128 MB of RAM; 256 MB is recommended.

• Internet Explorer version 5.0 or higher or Netscape version 4.01 or higher.

• Java 2 Runtime Environment (JRE), Standard Edition, version 1.2.2_08.

Note JRE is on the CTE Design Studio CD-ROM and is also available from
http://www.javasoft.com. JRE requires an additional 16 MB of disk space. Design Studio
does not work with other versions of JRE or the Java Development Kit (JDK).

• VGA color monitor with a graphics card capable of showing 16-bit color or higher. The minim
screen resolution supported is 640 x 480. The recommended resolution is 1280 x 1024.

• Network connection to the Cisco CTE 1400 Series and Design Studio support the formats m
commonly used for websites and wireless devices.

The network connection can be through a proxy server that you specify when logging in to De
Studio.
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Website content is supported in the following formats:

• HTML versions 4.0, 3.2, and 2.0

• XHTML versions 1.1 and 1.0

• XML version 1.0

• WML version 1.1

• XSL version 1.0

• GIF, JPEG, BMP, and WBMP image formats

The CTE and Design Studio support web pages that use any standard encoding; they transcode
pages to the formats required by all supported wireless devices: UTF-8, 7-bit ASCII, and Shift-JI
encoding.

Wireless device microbrowsers do not support all content types. The Cisco CTE 1400 Series pass
following content to a wireless device in its original format:

• Binary data, such as audio, video, and PDF files. (However, the CTE does support for IP pho
audio that is 8-bit G.711 Mu-Law audio codecs sampled at 8 kHz.)

• Java applets, plug-ins, and custom objects.

Table 1 lists the destination devices supported by the Cisco CTE 1400 Series.

Table 1 Supported Devices

Category Vendor and Model Models Tested

cHTML(1)1 Casio Cassiopeia EM-500

Compaq iPAQ iPAQ

Hewlett-Packard Jornada Jornada 525, Jornada 545, Jornada 720

Psion Revo Plus Revo Plus

cHTML(2) Research in Motion (all models) Blackberry, RIM 950

IP phones Cisco IP phones

Polycom SoundPoint

IP phones that support HTML

all

500CS

Palm HTML Handspring Visor (all models) Visor, Visor Deluxe, Visor Edge, Visor Neo,
Visor Platinum, Visor Prism, Visor Pro

Palm VII Palm VII

Sony CLIÉ CLIÉ PEG-S300

VoiceXML BeVocal, Tellme BeVocal, Tellme
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Upgrading the Cisco CTE 1400 Series and Design Studio
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Upgrading the Cisco CTE 1400 Series and Design Studio
This section describes how to upgrade your CTE and Design Studio to Release 2.5.

• Upgrading from Release 1.1.6, page 4

• Upgrading from Release 2.2, page 5

• Upgrade Procedures, page 5

• Upgrading Design Studio, page 7

• Uninstalling Design Studio, page 7

Note Before you upgrade a CTE, record its network and DNS parameters. You will need to reconfigure th
CTE after you upgrade it.

Upgrading from Release 1.1.6
To upgrade from Release 1.1.6, perform these steps:

Step 1 If you have not yet upgraded to the 2.2a release, use the 2.2a Restore CD to upgrade to Releas

If you do not have the 2.2a Restore CD, there are two ways to obtain the CD:

• Order it from the Cisco Technical Assistance Center (TAC) website:

http://www.cisco.com/tac

WML 2

version 1.1
(WAP-enabled
phones)

Alcatel (all models) OneTouch 701

Audiovox CDM-9000 CDM-9000

Benefon (Benefon Q) Benefon Q

Ericsson (all models) R320, R380, R380s, R520, T20, T29, T39

Motorola (all models) 250, 260, A008, P7389, P8767, StarTac v.50
(V2288 is not tested)

Nokia (all models) 6210, 7110, 9110, 9210

Panasonic (all models) GD93

Philips (all models) Azalis, Ozeo, Xenium

Samsung (all models) SCH-850, SGH-N100

Sanyo (all models) SCP-4500

Siemens (all models) S35, S45, Sl45

(IC35 is not tested)

Sony (all models) CMD-Z5

1. cHTML = Compact HTML

2. WML = Wireless Markup Language

Table 1 Supported Devices (continued)

Category Vendor and Model Models Tested
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• Download the ISO image file from Cisco Connection Online (CCO):

http://www.cisco.com

For instructions on downloading these files, see the“Download from CCO” section on page 5.

Step 2 Once you have upgraded to 2.2a, obtain a Release 2.5 Restore CD from Cisco TAC by calling
1-800-553-2447 in the United States. To obtain a directory of toll-free Cisco TAC telephone num
for all countries, go to the following URL:

http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml

Step 3 Once you have the Release 2.5 CD, follow the instructions in the“Upgrade from CD” section on
page 6.

Upgrading from Release 2.2
To upgrade from Release 2.2, follow the instructions in the“Upgrade from CD” section on page 6.

Upgrade Procedures
This section describes the following CTE upgrade procedures:

• Download from CCO, page 5

• Upgrade from CD, page 6

Download from CCO

There are three types of patch files you can download:

• Partial Upgrade—This recommended file installs no configuration files so you retain any exis
configuration information.

• Full Upgrade—This file installs new configuration files, overwriting any existing configuration
information.

• ISO Image File—This file contains the ISO image from which you can create your own CD.

Downloading a Partial or Full Upgrade Patch File

To download a partial or full upgrade file, perform these steps:

Step 1 Log on to the CCO website.

Step 2 Download the appropriate patch file.

For a partial upgrade that does not overwrite your configuration files, download the following patch

CTEServerPartialUpgrade-k9.2-2a.tgz

For a full upgrade that overwrites any existing configuration information, download the following pa
file:

CTEServerFullUpgrade-k9.2-2a.tgz
5
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Upgrading the Cisco CTE 1400 Series and Design Studio
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Step 3 Log on to the CTE Administration screens from any web browser, entering the following URL:

https://IP_address:9001

where:

• IP_address is the IP address of your CTE.

• 9001 is the administration port of your CTE.

Step 4 For a full upgrade, use your regular administrative username and password to log on to the
Administration screens. For a partial upgrade, useroot as the username andcteadmin as the default
password.

Step 5 From the Upload Server Upgrade field on Administration > Uploads screen, browse for the file to
upload, and select it.

Step 6 Click theSubmit button.

Step 7 Once the upload is complete, the CTE will automatically restart.

Step 8 If you downloaded the full patch file (CTEServerFullUpgrade-k9.2-2a.tgz), you will need to
reconfigure the CTE from the CTE console. For more information on reconfiguring the CTE, see 
description of the CTE Console menus in theCTE 1400 Configuration Note.

Downloading an ISO Image File

To download an ISO image file, perform these steps:

Step 1 Log on to the CCO website.

Step 2 Download the ISO Images file (CTEServerISO-k9.2-2a.zip).

Step 3 Burn a CD containing the ISO Images file information.

Step 4 Go to the“Upgrade from CD” section on page 6, and use the CD you have created in this procedure
upgrade your CTE.

Upgrade from CD

To upgrade from Release 2.2a to Release 2.5, perform these steps:

Step 1 Power up the system, and make sure that the CTE console is connected.

Step 2 Insert the CTE Release 2.5 Restore CD-ROM into the CD-ROM drive of the CTE.

Step 3 Power down the CTE.

Step 4 Wait approximately 10 seconds.

Step 5 Power up the CTE.

Step 6 The serial console displays the following messages during the upgrade:

CTE software installation will take 5 minutes to complete.
0%...................................................100%
Installation successful. Please eject the CD and reboot the CTE.
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Step 7 When the upgrade is complete, eject the Restore CD and reboot the CTE.

Step 8 When the CTE restarts, the CTE console interface appears.

Upgrading Design Studio
To upgrade Design Studio, install the Design Studio software from the CD. For more information
installing Design Studio, see theCisco CTE 1400 Series and Design Studio Quick Start Guide.

Note Design Studio automatically upgrades configuration files created in previous releases to th
release 2.5 format. When you attempt to open a configuration file, Design Studio gives you
the choice of overwriting the old file or saving it to a different name.

Uninstalling Design Studio
To uninstall an earlier version of Design Studio, perform these steps:

Step 1 On your desktop, selectStart > Settings > Control Panel > Add/Remove Programs.

Step 2 Carefully select the version of Design Studio you wish to remove from the displayed list, and clic
Remove.

Note On Windows 2000, the uninstall will occur right after you click theRemovebutton. On other
operating systems, a sequence of dialog boxes will guide you through the uninstall proce

Unsupported Software Elements
The CTE and Design Studio do not support the following items:

• Alerts confirmations and prompts.

• Application servers that do not expect a referrer on first redirect.

• Calls to a JavaScript Object that do not result in a lookup for any property named by a param
For example, the statementmyObject(‘myProp’), where (‘myProp’) is a parameter, will result in an
error.

• Check box and radio button click events.

• Doc.write.

• Dynamic select objects.

• Form elements that are not in a form tag.

• Form variables of different cases do not resolve because form.named_input is case sensitive

• Forms and their input elements can be referenced by name only.

• Frames.

• Iframe tags.
7
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• Incorrectly nested head and body tags.

• Internet Explorer-specific JavaScript, such as Document.all.

• JavaScript URLS in places other than anchor tags.

• javascript:history.back().

• Multipart MIME type.

• Netscape layers.

• POST data that is larger than 32768 bytes.

• Relative anchors (for example, <a href=#>).

• Unclosed anchors.

• Window.open.

New Features in Release 2.5
These sections describe new features in the Cisco CTE 1400 Series and Design Studio release 

• New Features in the Cisco CTE 1400 Series, page 8

• New Features in Design Studio, page 9

New Features in the Cisco CTE 1400 Series
These sections describe the new features for the CTE 1400 Series release 2.5:

• Changes to CTE Console Menu, page 8

• CTE 1400 Series Administration Screens, page 8

• Other New CTE Features, page 9

For more information, see theCTE 1400 Series Configuration Note.

Changes to CTE Console Menu

The CTE Console menu has been restructured to contain five options plus submenus for setting 
CTE, such as defining networking and DNS parameters, pinging other machines in the network, de
administrative users, and restarting and shutting down the CTE.

CTE 1400 Series Administration Screens

The CTE 1400 Series Administration screens let you monitor and maintain the activity on your C
from any browser on the Internet. Through this interface, you can set or display the following:

• Network Settings, such as the IP address, subnet mask, masquerade host, duplex mode, an
for Interfaces 0 and 1, default gateway, gateway interface, listen-on interface,
HTTP/HTTPS/Administration ports, DNS servers and domain, static routes, and proxies.

• Advanced Settings, such as default URL, default host, session timeout, minimum session tim
maximum buffer size, browser masquerade, input character encoding, JavaScript emulation,
outbound and incoming keepalive messages, unrestricted proxy, and defining usernames an
passwords for use with an IP phone.
8
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• Logging Settings, such as enabling and displaying SNMP messages, the system log, the hea
(device driver and load statistics), and version information.

• Administration Settings, such as defining Design Studio users and uploading secure certificate
server upgrades.

Other New CTE Features

Other new CTE features include the following:

• For IP phones, the CTE now supports audio that is 8-bit G.711 Mu-Law audio codecs sample
8 kHz.

• Ability to upload secure certificates and server upgrades from the Administration screens. (T
functions were formerly in Design Studio.)

• Expanded input character encoding formats.

• Local proxy exclusion (if specified, the defined proxy server is ignored in the local domain), p
the ability to exclude IP addresses, hosts, and domains from using the defined proxy server.

• Ability to define a default username and password for IP phones.

New Features in Design Studio
These sections describe the new features in Design Studio release 2.5:

• Usability Improvements, page 9

• New Features for IP Phones, page 10

• Other New Features and Changes in Design Studio, page 10

For more information, see theDesign Studio User Guide.

Usability Improvements

• When you start Design Studio, the window includes a list of recently opened configuration fil

• Design Studio includes more visual clues to help lead you through the process of creating a
configuration file, creating a project, and adding a page to a project.

• Design Studio includes an HTML-based online Help system which includes search and book
capabilities. You can click the Help button in a dialog box for help on that dialog box, or you 
open the Help from the Design Studio Help menu.

• Settings used to configure path elements appear in the Configure dialog boxes rather in a se
dialog box.

• The Path to Selected Element list now indicates repeated elements through the icon . If you
to apply a rule to multiple depths or positions, that icon suggests which elements you should
consider iterating.

• Device types are now grouped under the heading "Transformation Rules" in the project tree.

• The status bar contains more information, including the CTE IP address, the name of the logg
user, and the full path and filename of the open configuration file.
9
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New Features for IP Phones

The following new features in Design Studio significantly improve the support for IP phones. For m
information, refer to the newIP Phone Solutions Guide and theDesign Studio User Guide.

• The Design Studio window includes a Preview tab for IP phones. The Preview tab includes a li
each card that results from the transformation of a web page and includes an IP phone emulato
IP phone emulator helps you preview your transformation results. To follow links in a
transformation, you must use an actual IP phone.

• You can group a set of links so that only the links display on the IP phone. Grouping links is 
convenient way to remove content other than links.

• You can add up to three Soft Keys to one or all cards that result from the transformation of a
page for an IP phone. You can create Soft Keys, convert links to Soft Keys, or convert phone
numbers to Soft Keys.

• You can specify the input type for an input field. Theinput  andtextarea elements default to the
input type ASCII. You can change that input type, for example to limit user input to all capital
letters. You can also add a label for an input field.

• You can specify a refresh interval so that one or more cards are automatically refreshed on t
phone, without user action. This action is useful if you want to briefly show an icon or some t
before continuing to the next card.

• New XHTML extensions enable you to implement the Soft Keys, Input Type/Label, and Refre
rules directly in your source pages.

Other New Features and Changes in Design Studio

• You can now connect to a CTE from Design Studio through a proxy server. You specify the p
host and ports when logging into Design Studio.

• Digital certificates are no longer downloaded through Design Studio. This administrative func
is now handled through the CTE administrator interface.

• The Dial rule allows you to specify whether a phone number can be edited by a user. You might
to allow a user to edit a number if the user might need to enter an access code or prefix before d
the number.

• You can group a set of links so that only the links display on a WAP phone. Grouping links is
convenient way to remove content other than links.

Documentation Updates
This section describes documentation updates in Cisco CTE 1400 Series and Design Studio relea

FlexLM Licensing
Although on pages 5 and 30 the printed version of theCTE Configuration Note mentions FlexLM
licensing as a supported feature, FlexLM licensing is not supported in Release 2.5.
10
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Configuring a CTE with a Server Load Balancer
The CTE can be configured to operate in a load-balanced environment. When a CTE is set up w
server load balancer (SLB), requests are generated to the IP address of the SLB, which sends the
to an appropriate web server.

The SLB must be configurable to provide real-time header parsing. To configure the SLB, perform t
steps:

Step 1 From the Advanced > General screen of the CTE Administration screens, set the default host as
address of the SLB.

Step 2 For optimal performance, use the SLB configuration tools to do the following:

a. Configure additional virtual IP addresses. These IP address can be used by the CTE when
reestablishing connection to the SLB.

b. Configure the SLB so it does not parse the HTTP headers received on the virtual IP addresses,
saves performance time.

The following sequence of events occurs when a client requests content, and the SLB encounter
CTE-supported user agent string:

1. The client requests a web page from a domain.

2. The SLB forwards the request to the CTE.

3. The CTE reissues the request to the default host masquerading as the user agent.

4. The SLB receives the request and directs it to the appropriate web server.

5. The web server retrieves the content and passes it through the SLB to the CTE.

6. The CTE transforms the content and sends it back through the SLB and on to the client devi

Specifying a Default URL
You can specify a default URL for each interface of the CTE. Then when a request comes in on Inte
0, the CTE will automatically use the default URL 0. This action is useful for installation in a
demilitarized zone (DMZ), where one interface is internal and one is external.

Obtaining Version Information
You can determine which version of the CTE software you are using in either of the following wa

• In the CTE Administration screens under the Logging tab, the last item in the left column disp
software version information.

• In the CTE console, every time you pressEnter the CTE console displays the software version
information.
11
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Script and Noscript Issues
Be aware of the following script and noscript issues:

• The contents ofnoscript elements are displayed by default, and you must clip this text if you do n
want it displayed.

• Because the CTE interprets bothscript andnoscript elements, accessing some Web sites can p
the CTE into a loop. This condition can occur when a site has two pages, one for JavaScript-en
browsers and another for no JavaScript-enabled browsers. These pages may contain redirects
other, so a JavaScript-enabled browser is redirected to the JavaScript page and non-JavaSc
browsers are sent to the non-JavaScript page. Because the CTE interprets bothscript andnoscript
elements, it goes into a loop. The workaround is to clip the meta refresh element so that the re
is ignored.

DDF Editor Issues
Be aware of the following DDF Editor issues:

• If the useragent or filteragent element string contains brackets, they must be preceded by a bac
(\) to create a proper regular expression.

For example, the expression ^.*(Mozilla/2.0 \(compatible; Elaine/3.0\).*$ is correct.

The expression ^.*(Mozilla/2.0 (compatible; Elaine/3.0)).*$ is incorrect.

• If you add a new device in the DDF Editor, close the DDF window, and load the page, the page
not load properly to be displayed on other devices. When adding a new device in the DDF E
make sure that you supply a useragent string so the page will be displayed correctly on other de

Dial Number Rule Issue
The Dial Number rule does not work on an IP Phone when applied to an element if the label is the
as the element. For example, if you attempt to apply the rule to a phone number 888-123-1234, an
label is also 888-123-1234, the rule will not work, and the phone number will not display in the “Ph
Number on this page” list on the IP phone.

Open and Resolved Caveats in Release 2.5
This section contains the following topics:

• Open Caveats in the Cisco CTE 1400 Series, page 12

• Open Caveats in Design Studio, page 13

• Resolved Caveats in the Cisco CTE 1400 Series, page 13

• Resolved Caveats in Design Studio, page 14

Open Caveats in the Cisco CTE 1400 Series
There are no open caveats for the CTE in this release.
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Open Caveats in Design Studio
This section describes the known limitations in Design Studio release 2.5.

• CSCdy07672

When using the Paginate rule to paginate an anchor that contains a slash <href> statement
(<href>=’/’), the Paginate rule does not appear to work while you are in Design Studio. It doe
however, produce the correct results on display devices.

Workaround: The Paginate rule used as described works fine when content is displayed on de

• CSCdy07687

A CTE file is not saved to disk if you save it with a blank text field. This situation can happen wh
you add a URL to a project, click theOpen Configuration button, and typeYeswhen asked to save
the file. When you sayYes, a File Save dialog box appears with a blank file name text field. If yo
click theSave button with no file name specified, the file is not saved and your work is lost.

Workaround:  Be sure to enter a name in the file name text field of the File Save Dialog box.

This problem is a condition of Java 1.2.2 and will no longer be an issue in subsequent releas
Design Studio, which will use Java 1.3.

• CSCdy07696

When you enter eitherFile > Open or File > Save As and the appropriate dialog box appears, th
list/detail icons in the upper-right corner of the dialog box do not work.

Workaround: This problem is a condition of Java 1.2.2 and will no longer be an issue in subseq
releases of Design Studio, which will use Java 1.3.

• CSCdy015717

If the alt tag contains a comma, the IP Phone will not load an image page.

Workaround: Use a Modify rule to remove the comma, or ignore the alt tags altogether to navig
the entire page.

Resolved Caveats in the Cisco CTE 1400 Series
This section describes the caveats resolved in Cisco CTE 1400 Series release 2.5.

• CSCdx25146

On pages using the base tag to set an absolute URL for interpreting relative links, JavaScript-re
browsing will fail with 404 errors. When JavaScript creates relative URLs (URLs that require 
URL of the current resource to be interpreted correctly), they are interpreted relative to the UR
the page, rather than to the URL of the base tag.

Resolution: Relative URLs are now interpreted to automatically select the base tag.

• CSCdx25191

In the CTE console, if you set HTTP parameters before setting networking parameters, your se
will not take effect until you restart the CTE.

Resolution: The order for setting parameters is not an issue in this release.
13
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Resolved Caveats in Design Studio
There are no resolved caveats in Design Studio for this release.

Open and Resolved Caveats in Release 2.2
This section contains the following topics:

• Open Caveats in the Cisco CTE 1400 Series, page 14

• Open Caveats in Design Studio, page 14

• Resolved Caveats in the Cisco CTE 1400 Series, page 14

• Resolved Caveats in Design Studio, page 15

Open Caveats in the Cisco CTE 1400 Series
This section describes the known limitations in Cisco CTE 1400 Series release 2.2.

• CSCdx25146

On pages using the base tag to set an absolute URL for interpreting relative links, JavaScript-re
browsing will fail with 404 errors. When JavaScript creates relative URLs (URLs that require 
URL of the current resource to be interpreted correctly), they are interpreted relative to the UR
the page, rather than to the URL of the base tag.

Workaround: None.

Open Caveats in Design Studio
This section describes the known limitations in Design Studio release 2.2.

• CSCdx25219

In Design Studio, you can only upload DDF files the first time you enter the DDF editor. Subsequ
DDF file upload attempts will not work. Before each subsequent DDF file upload, select the
commandFile > Connect to CTE 1400 in Design Studio.

Workaround:  Reconnect to the CTE each time you reenter the DDF editor.

Resolved Caveats in the Cisco CTE 1400 Series
This section describes the caveats resolved in Cisco CTE 1400 Series release 2.2.

• CSCdx25191

In the CTE console, if you set HTTP parameters before setting networking parameters, your se
will not take effect until you restart the CTE.

Resolution: The order for setting these CTE parameters is no longer relevant, and you can set
in any order.
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Resolved Caveats in Design Studio
This section describes the caveats resolved in Design Studio release 2.2.

• CSCdx25203

If Design Studio is open but inactive over an extended period of time, you may not be able to
continue without restarting your Design Studio session.

Resolution: Leaving Design Studio open and inactive for long time periods no longer requires
to restart your Design Studio session.

Open and Resolved Caveats in Release 2.1
This section contains the following topics:

• Open Caveats in the Cisco CTE 1400 Series, page 15

• Open Caveats in Design Studio, page 15

• Resolved Caveats in the Cisco CTE 1400 Series, page 15

• Resolved Caveats in Design Studio, page 17

Open Caveats in the Cisco CTE 1400 Series
This section describes the known limitations in Cisco CTE 1400 Series release 2.1.

• CSCdx25191

In the CTE console, if you set HTTP parameters before setting networking parameters, your se
will not take effect until you restart the CTE.

Workaround:  Set networking parameters before you set HTTP parameters.

Open Caveats in Design Studio
There are no open caveats in Design Studio for this release.

Resolved Caveats in the Cisco CTE 1400 Series
This section describes the caveats resolved in Cisco CTE 1400 Series release 2.1.

• CSCdv61609

The CTE does not retain a backup version of a configuration file. When you publish a configura
file, it overwrites the previous configuration file.

Resolution: Design Studio keeps a backup version of a configuration file. When you publish a
configuration file, you have the option of merging or overwriting the previous file.
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• CSCdv61681

If Design Studio is open but inactive over an extended period of time, you may not be able to
continue without restarting your Design Studio session.

Resolution: Be sure that the resource levels on your system do not become depleted.

• CSCdv61686

Websites that are coded in WML do not pass through the CTE if the URL to the site is relativ
the URL to the WML-coded site is absolute, the site content passes through the CTE.

Resolution: The CTE supports relative URLs to WML-coded sites.

• CSCdv61689

When CTE console option 9 (Set Secure Proxy) is disabled, SSL/HTTPS sessions are conver
HTTP and are, thus, unsecure.

Resolution: To access secure sites from the CTE, you must either enable secure redirects or s
the device-to-CTE connection through a secure port and HTTPS. This procedure is not require
IP phones.

• CSCdv61691

Input fields that are created with thetextarea element do not work on WAP devices.

Resolution: The CTE automatically transformstextarea elements toinput  elements.

• CSCdu87742

The CTE supports HTTP Basic Authentication only.

Resolution: The CTE supports Windows NT Challenge/Response Authentication (also referre
as NTLM).

• CSCdu87802

The CTE currently supports only strong (128-bit) Secure Sockets Layer (SSL) encryption for
incoming connections.

Resolution: The CTE supports all SSL encryption.

• CSCdu87807

Although you can specify Dynamic Host Configuration Protocol (DHCP) as the boot protocol
(option 2 in the CTE console), the CTE works only with DHCP servers that are configured to re
a host name.

Resolution: The CTE does not support DHCP.

• CSCdu87829

The masquerade IP address defaults to an invalid value.

Resolution: The default value is now correct.

• CSCdu87834

The CTE processes web pages only from servers that return a valid content type, either “text/h
or “text/xml.” The CTE does not transform a web page with any other content type and passes
wireless devices as is.

Resolution: Set up your server to return a supported content type.
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Resolved Caveats in Design Studio
This section describes the resolved caveats in Design Studio release 2.1.

• CSCdv61702

Two consecutive upgrades to the CTE cause Design Studio to hang.

Resolution: Design Studio no longer hangs after consecutive upgrades.

• CSCdv61706

You cannot select content that is generated by a style sheet in the browser view.

Resolution: You can now select the generated content in either view.

• CSCdu87906

After the following sequence of steps, Design Studio is unable to load additional web pages:

a. Start Design Studio.

b. Create a new project.

c. Browse towww.yoursite.com.

d. Add a page to the project.

e. Remove the page from the project.

f. Browse towww.yoursite.comn. (Notice the spelling at the end of the URL.)

Resolution: Design Studio now handles the page loading correctly.

• CSCdv64986

Design Studio cannot save a configuration file that contains an XML page with aCDATA  section.

Resolution: Design Studio supports XML pages with aCDATA  section.

• CSCdv64987

Design Studio does not correctly store the name of Paginate Identifier rules in a configuration
When you open a configuration file, Paginate Identifier rules might not have a name.

Resolution: Design Studio correctly stores the name of Paginate Identifier rules.

• CSCdu87868

The scroll bars in the XHTML source view are incorrect. This problem occurs as the result of
known issue with JRE/JDK version 1.2.2 that will be resolved in a future release.

Resolution: The scroll bars display correctly.

• CSCdu87887

You cannot rename a page or project in Design Studio.

Resolution:You can now right-click a page or project name in the Design Studio window to chan
it.

• CSCdu87896

After applying a rule or clicking a tab, the Edit or View Original tab is blank.

Resolution: The Edit and View Original tabs display correctly.
17
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• CSCdu87903

When you click a link in either the Edit tab or View Original tab, Design Studio sometimes displa
the link destination instead of selecting the link.

Resolution: Design Studio selects links that are clicked in the Edit or View Original tabs.

• CSCdu87911

You cannot save a configuration file (.cte) with an extension that contains a "/" or "\".

Resolution:Design Studio displays a warning dialog box if you attempt to save a configuration
to a name with invalid characters.

• CSCdu87920

After browsing to a page in Design Studio, the URL listed in the Address field is incorrect. Th
problem occurs if the server where the web page originates is returning a content type other
“text/html” or “text/xml.”

Resolution: Set up your server to return a supported content type.

Open and Resolved Caveats in Release 2.0
There are no new caveats for this release.

Open and Resolved Caveats in Release 1.1.6
This section contains the following topics:

• Open Caveats in the Cisco CTE 1400 Series, page 18

• Open Caveats in Design Studio, page 19

• Resolved Caveats in the Cisco CTE 1400 Series, page 19

• Resolved Caveats in Design Studio, page 20

Open Caveats in the Cisco CTE 1400 Series
This section describes the known limitations in Cisco CTE 1400 Series release 1.1.6.

• CSCdv61558

The default browser on a Palm device cannot handle more than two consecutive redirect req
When that occurs, the Palm device displays the message “You’ve been redirected too many 

Workaround:  Use the Blazer browser instead of the Elaine browser for Palm devices.

• CSCdv64990

Design Studio allows you to publish a configuration file that does not contain any identifier ru
Without an identifier rule, a configuration file matches all pages. As a result, a wireless device
can retrieve any page through the CTE, even if console option 12 (Enable Unrestricted Proxy
Support) is disabled.

Workaround:  Include at least one identifier rule per page in a configuration file.
18
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Open Caveats in Design Studio
This section describes the known limitations in Design Studio release 1.1.6.

• CSCdv61707

Design Studio supports only the XSL and XHTML namespaces. If you import an XSL style sh
that contains references to other namespaces, the console displays a message such as the fo
“Unsupported stylesheet operation: no such prefix: rdf.”

Workaround:  Remove references to unsupported namespaces in XSL style sheets.

• CSCdv64983

Design Studio does not support XSL style sheets that have anxsl:import  element followed by an
xsl:include element. If you attempt to add a page to an XML project that uses such a style shee
CTE console displays the error MalFormedURLException and you will need to stop and rest
Design Studio.

Workaround:  Combine the XSL style sheet referenced by thexsl:include element with the style
sheet referenced by thexsl:import  element. Design Studio supports thexsl:import  element.

Resolved Caveats in the Cisco CTE 1400 Series

Note The *** in this section indicate that the caveat was reported and resolved after release 1.1.5.

This section describes the caveats resolved in Cisco CTE 1400 Series release 1.1.6.

• CSCdu87787

The CTE assumed that the network mask set for the second network interface card (eth1) is the
for the first network interface card (eth0).

Resolution: You can set the network mask for eth1 by using the CTE console option3 (Set
Networking Parameters) as described in theCisco Content Transformation Engine 1400 Series
Configuration Note.

• CSCdv61555***

WML devices that use the pre-3.1 version of the Openwave Mobile Browser (UP.Browser)
sometimes displayed a Form Compilation Error when attempting to handle forms.

Resolution: The CTE correctly handles the forms on the earlier versions of the UP.Browser.

• CSCdv61567***

When browsing on a Palm VII, clicking a Submit button sometimes resulted in the display of 
same page.

Resolution: The correct page is now loaded.

• CSCdu87815

Decimal character references below 160 will be encoded differently in release 1.1.6. The enco
change will affect any rules that include these special characters.

Resolution:The encoding for decimal character references has changed. Design Studio conver
encoding when you open a release 1.1.5 configuration file in release 1.1.6.
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• CSCdu87822

The CTE could not access a website from behind a proxy firewall. To your website, the CTE
appeared as a browser, like Internet Explorer or Netscape. If you set up your website to use a
server, the CTE was unable to access pages from your website.

Resolution: The CTE now supports proxy servers.

• CSCdu87918

If you configure a cache engine to cache pages from the CTE, you can log in to the CTE but ca
retrieve web pages from it. This problem has been observed only with the Cisco cache engin

Resolution: Set your cache engine to bypass mode. Review the configuration note for your ca
engine for instructions.

• CSCdv61599***

Unless option 4 (Set Masquerade Host) was set in the CTE console, you could not follow link
WAP-enabled phones that use WML.

Resolution: You no longer have to set a masquerade host to follow links on WAP-enabled ph
that use WML.

• CSCdu87847

The CTE sometimes did not correctly handle a form on WML and IP phones if the form had an in
type of “hidden” and a value that contained the "%" character.

Resolution: The CTE correctly handles the forms.

• CSCdv61604***

Some servers return a content-type value of “text/plain” for XML documents. Because the CT
chose a parser based on the content-type value, the wrong parser was used for XML docum

Resolution: The CTE now chooses a parser based on the filename extension, rather than the
content-type value.

• CSCdv61612***

A CTE attempting to perform more than two transformations simultaneously will successfully
handle only one of the transformations and will not respond to the other requests.

Resolution: The CTE correctly handles multiple simultaneous transformations.

Resolved Caveats in Design Studio

Note The *** in this section indicate that the caveat was reported and resolved after release 1.1.5.

This section describes the resolved caveats in release 1.1.6 of Design Studio.

• CSCdu87874

When uploading a configuration file to the CTE, Design Studio appeared to hang.

Resolution: Design Studio displays a progress bar, so you can monitor the progress of the up
20
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• CSCdv61624***

When you saved a configuration file, Design Studio did not check for a file of the same name in
directory and display the Save As dialog box.

Resolution: Design Studio displays the Save As dialog box when you attempt to save a
configuration file with a duplicate filename.

• CSCdv61628***

If you attempted to browse to a page while Design Studio was publishing a configuration file to
CTE, Design Studio displayed a message that there was a problem with the upload although
completed successfully.

Resolution: Design Studio no longer displays an error message when the upload completes
successfully.

• CSCdu87913

A page sometimes rendered differently in the Edit tab and the Browse tab. This problem occ
when you created a rule with the Match Element Name field not selected and the Position to M
option set to a range. Design Studio incorrectly calculated the range in the Edit tab.

Resolution: Pages now render correctly in the Edit tab.

• CSCdv61635***, CSCdv61637***

Design Studio sometimes worked incorrectly when you attempted to save a configuration file
some cases, a Java NullPointerException occurred; in other cases, Design Studio incorrectly
interpreted a filename as invalid.

Resolution: Design Studio now correctly saves configuration files.

• CSCdu87916

Design Studio allowed thep element to be hierarchical. Any rule associated with ap element may
not have resulted in a correct transformation.

Resolution:Design Studio no longer allows thep element to be hierarchical. Design Studio correc
the transformation rules for thep element when you open a 1.1.5 configuration file in release 1.1

• CSCdv61639***

Design Studio did not correctly display some UTF-8 characters, such as the bullet character.

Resolution: Design Studio correctly displays the special characters.

• CSCdu87925

The Dial rule could not prepend a "9" or other number to access an external number.

Resolution: The Configure: Dial Rule dialog box now includes a text box for entering a phone
number prefix.

• CSCdv61642***

Clicking the Close button in the Save As dialog box did not close the dialog box and displaye
Conflict message box.

Resolution: The Close button in the Save As dialog box works correctly.

• CSCdv61652***, CSCdv61661***

The Find dialog box did not work correctly when the search string included a space or the follow
special characters: /, <, >, =.

Resolution: The Find dialog box handles spaces and special characters.
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• CSCdv61664

Design Studio might not display the content of anoframes element in the browser view.

Resolution: Design Studio always displays the content of anoframes element.

• CSCdv61667***

Design Studio incorrectly calculated the range values in the Configure Element dialog boxes

Resolution: Design Studio correctly calculates the range values.

Open Caveats in Release 1.1.5
This section contains the following topics:

• Open Caveats in the Cisco CTE 1400 Series, page 22

• Open Caveats in Design Studio, page 22

Open Caveats in the Cisco CTE 1400 Series
This section describes the known limitations in Cisco CTE 1400 Series release 1.1.5.

• CSCdu87770

The CTE does not support web pages that exceed 256 KB.

Workaround: None. In a future release, the CTE console will allow you to configure the suppor
page size.

• CSCdu87856

You must choose the encoding type that is used for web pages from the CTE console. The enc
type you choose applies to all web pages.

Workaround: The CTE uses Latin-1 encoding by default, which will work for most pages that a
not encoded in Unicode Transformation Format-8 (UTF-8). We recommend that you use Lati
encoding for HTML-based pages and UTF-8 encoding for XML documents. You can also cho
raw, ASCII, or macro encoding.

Open Caveats in Design Studio
This section describes the known limitations in Design Studio release 1.1.5.

• CSCdu87891

The drop-down menus in the Log in to the Cisco CTE 1400 Series dialog box do not retain
previously selected values. For example, if you change the value of the User Name field, the
previously selected value no longer appears in the menu. This problem occurs as the result 
known issue with JRE/JDK version 1.2.2.

Workaround:  Enter a value.
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• CSCdu87893

You cannot delete or edit multiple rules simultaneously by selecting them in the Transformat
Rules or Identifier Rules lists and then clicking the Delete or Edit button. Design Studio perfo
the command only on the last rule selected.

Workaround:  Delete or edit the rules individually.

Additional Documentation
The following documents are available for the Cisco CTE 1400 Series and Design Studio:

• Cisco CTE 1400 Series and Design Studio Quick Start Guide

• Cisco CTE 1400 Series Hardware Installation Guide

• Cisco Content Transformation Engine 1400 Series Configuration Note

• Design Studio User Guide

Obtaining Documentation
The following sections explain how to obtain documentation from Cisco Systems.

World Wide Web
You can access the most current Cisco documentation on the World Wide Web at the following U

http://www.cisco.com

Translated documentation is available at the following URL:

http://www.cisco.com/public/countries_languages.shtml

Documentation CD-ROM
Cisco documentation and additional literature are available in a Cisco Documentation CD-ROM
package, which is shipped with your product. The Documentation CD-ROM is updated monthly and
be more current than printed documentation. The CD-ROM package is available as a single unit
through an annual subscription.
23
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Ordering Documentation
Cisco documentation is available in the following ways:

• Registered Cisco Direct Customers can order Cisco product documentation from the Networ
Products MarketPlace:

http://www.cisco.com/cgi-bin/order/order_root.pl

• Registered Cisco.com users can order the Documentation CD-ROM through the online Subscr
Store:

http://www.cisco.com/go/subscription

• Nonregistered Cisco.com users can order documentation through a local account representa
calling Cisco corporate headquarters (California, USA) at 408 526-7208 or, elsewhere in Nor
America, by calling 800 553-NETS (6387).

Documentation Feedback
If you are reading Cisco product documentation on Cisco.com, you can submit technical comme
electronically. Click theFax or Email option under the “Leave Feedback” section at the bottom of t
Cisco Documentation home page. After you complete the form, print it out and fax it to Cisco at
408 527-0730.

You can e-mail your comments to bug-doc@cisco.com.

To submit your comments by mail, use the response card behind the front cover of your docume
write to the following address:

Cisco Systems
Attn: Document Resource Connection
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

Obtaining Technical Assistance
Cisco provides Cisco.com as a starting point for all technical assistance. Customers and partner
obtain documentation, troubleshooting tips, and sample configurations from online tools by using
Cisco Technical Assistance Center (TAC) Website. Cisco.com registered users have complete acc
the technical support resources on the Cisco TAC Website.

Cisco.com
Cisco.com is the foundation of a suite of interactive, networked services that provides immediate,
access to Cisco information, networking solutions, services, programs, and resources at any time
anywhere in the world.
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Cisco.com is a highly integrated Internet application and a powerful, easy-to-use tool that provid
broad range of features and services to help you to:

• Streamline business processes and improve productivity

• Resolve technical issues with online support

• Download and test software packages

• Order Cisco learning materials and merchandise

• Register for online skill assessment, training, and certification programs

You can self-register on Cisco.com to obtain customized information and service. To access Cisco
go to the following URL:

http://www.cisco.com

Technical Assistance Center
The Cisco TAC is available to all customers who need technical assistance with a Cisco product
technology, or solution. Two types of support are available through the Cisco TAC: the Cisco TAC
Web Site and the Cisco TAC Escalation Center.

Inquiries to Cisco TAC are categorized according to the urgency of the issue:

• Priority level 4 (P4)—You need information or assistance concerning Cisco product capabilit
product installation, or basic product configuration.

• Priority level 3 (P3)—Your network performance is degraded. Network functionality is noticea
impaired, but most business operations continue.

• Priority level 2 (P2)—Your production network is severely degraded, affecting significant asp
of business operations. No workaround is available.

• Priority level 1 (P1)—Your production network is down, and a critical impact to business operati
will occur if service is not restored quickly. No workaround is available.

Which Cisco TAC resource you choose is based on the priority of the problem and the conditions
service contracts, when applicable.

Cisco TAC Website

The Cisco TAC Website allows you to resolve P3 and P4 issues yourself, saving both cost and time. The
site provides around-the-clock access to online tools, knowledge bases, and software. To acces
Cisco TAC Website, go to the following URL:

http://www.cisco.com/tac

All customers, partners, and resellers who have a valid Cisco services contract have complete ac
the technical support resources on the Cisco TAC Website. The Cisco TAC Website requires a Cisc
login ID and password. If you have a valid service contract but do not have a login ID or passwor
to the following URL to register:

http://www.cisco.com/register/
25
Release Notes for Cisco CTE 1400 Series and Design Studio Release 2.5

78-13086-05

http://www.cisco.com
http://www.cisco.com/tac
http://www.cisco.com/register/


Obtaining Technical Assistance

.com
RL:

o TAC

ty

o TAC

g

pport
ork

your

 of 
If you cannot resolve your technical issues by using the Cisco TAC Website, and you are a Cisco
registered user, you can open a case online by using the TAC Case Open tool at the following U

http://www.cisco.com/tac/caseopen

If you have Internet access, it is recommended that you open P3 and P4 cases through the Cisc
Website.

Cisco TAC Escalation Center

The Cisco TAC Escalation Center addresses issues that are classified as priority level 1 or priori
level 2; these classifications are assigned when severe network degradation significantly impacts
business operations. When you contact the TAC Escalation Center with a P1 or P2 problem, a Cisc
engineer will automatically open a case.

To obtain a directory of toll-free Cisco TAC telephone numbers for your country, go to the followin
URL:

http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml

Before calling, please check with your network operations center to determine the level of Cisco su
services to which your company is entitled; for example, SMARTnet, SMARTnet Onsite, or Netw
Supported Accounts (NSA). In addition, please have available your service agreement number and
product serial number.
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